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g.USBamp and g.MOBIlab+ are biosignal acquisition systems for EEG, ECG, EMG, 
EOG and other sensors. In this tutorial the usage of the devices for a SSVEP BCI will 
be shown. For the proper working of the device also g.STIMbox and g.SSVEPbox are 
necessary. The Simulink Highspeed On-line Processing blockset allows to read in 
data into Simulink in real-time and to perform the parameter estimation and 
classification. No additional compilation of the Simulink model is required for the on-
line processing. 
 
 
PREPARATION 
 
Before start there are a few important things to check: 

 The g.USBamp or g.MOBIlab+ must be connected to the computer and 
switched on 

 g.GAMMAbox must be connected and switched on 

 The g.STIMbox and the g.SSVEPbox must be connected to the computer 

 Make sure that the COM ports for all devices are set correctly (see gSTIMbox 
Help). 
 
 

APPLYING THE ELECTRODES 
 
Apply the electrodes to the positions depicted below. Make sure that they are 
connected to the g.GAMMAbox in the right order. The following figure lists the correct 
configuration. 
 
 

 

Position 
 
 
PO7 
PO3 
POz 
PO4 
PO8 
O1 
Oz 
O2 
Fpz 
Right Earlobe 

Channel 
number 
 
1 
2 
3 
4 
5 
6 
7 
8 
GND 
Ref 
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INSTALLATION 
 

Copy the directory gSSVEP_8ch to your local hard disc. You have to manually set 
the path for MATLAB by selecting Set Path in the File menu. Click the Add with 
Subfolders button, and select the directory 
Your Installation path:\gSSVEP_8ch\ 

 

 
 

 

Click Save and Close to finish the path settings. 
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START-UP 
 
The corresponding Simulink models can be started from the MATLAB Start button 
 

 
 
or by typing the name of the Simulink model into the MATLAB command line. 
 

To start the g.USBamp SSVEP model type gSSVEP_gUSBamp_8ch into the MATLAB 

command line. 
 
The following Simulink model opens: 
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To start the g.MOBIlab+ SSVEP model type gSSVEP_gMOBIlabplus_8ch into the 

MATLAB command line. 
 
In that case this Simulink model opens: 
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DRIVER CONFIGURATION 
 
g.USBamp 
 
Double click on the g.USBamp block to open the following window: 
 

 
 

Enter the serial number of your g.USBamp, select a Sampling rate of 256 Hz and a 

Frame length of 1. Then select channels CH01-CH08, set Common ground and 

Common reference for Group A and Group B. Apply a Bandpass filter with lower-
cut-off frequency of 0.5Hz and upper-cut-off frequency of 30Hz and a 50Hz Notch 
filter. 
 
Now g.USBamp is correctly initialized. 
 
Save the settings by clicking on the Save … button and enter a filename to store the 
settings. 
 
Press OK to accept the settings and to close the window. 
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g.MOBIlab+ 
 

Double click on the g.MOBIlab+ block to open the following window: 
 

 
 

Select CH 1-8, set the Digital Channel 1-8 parameters to OFF and select the COM 

Port where your amplifier is connected to the PC. 
 
Press OK to accept the settings and to close the window. 



SSVEP BCI 

 

g.tec medical engineering GmbH v2.12.01 8 

MINIMUM ENERGY 
 

The sampling frequency of g.USBamp is 256 Hz. It is connected to an Unbuffer 

block and Data Type Conversion block to work with data in double precision format.  
The data is passed to the Minimum Energy block to calculate the signal-to-noise 
ratio (SNR) for the frequencies, specified in the Stimulation Frequencies block, with 
respect to the base EEG-signal. 
 
A double-click on the Minimum Energy block opens the following dialog: 
 

 
 
Buffer Length is the number of used samples for estimating the SNR, the minimum 

is 128 samples. A buffer length between 512 and 1024 samples is recommended. 

For the tutorial please enter 768 samples. 

 
Reestimate every N seconds: Time period after which the SNR shall be 

reestimated, minimum is 0.1 seconds. 

Enter 0.2 s, that is a re-estimation rate of 5Hz. 

 
Number of Harmonics to include in model: The number of harmonics the Minimum 
Energy estimator shall consider when building the signal models for each frequency, 

minimum is 0. 1, which includes the first order harmonic is used within this tutorial. 

 
Order of AR model: The minimum energy estimator uses the Levinson AR model to 
estimate the frequency spectrum of the signals. The order of the model is defined 
through this parameter. Minimum model order is 3. A model order between 5 and 7 is 
recommended. 
Set the Order of AR model to 7. 
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MEDIAN FILTER 
 

The Moving Median Filter smoothes the output signal of the Minimum Energy block 
by calculating the median of the data. 
 
Double click on the Median Filter block to open the following window: 
 

  
 
Filter Length: The number of samples which are used for calculating the median. 

Set the Filter Length to 10. 

 
 
PARADIGM 
 
Double click on the Paradigm block to open the following window: 
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Class Info File: Set the path of the Class Info File. 
 

Mode: 

The window allows selecting between three modes: (i) Training Paradigm, (ii) 

Paradigm with feedback and (iii) Free running.  

 

Trial period defines the length of one trial in seconds. It should not be shorter than 
8s  
 
Active Part [%] defines the time duration the user has to concentrate on a LED 
during one single trial period. It is specified as percentage of the trial period. 
 
Initial Offset defines the length before starting with the first trial in seconds. It should 
not be set to values less than 10s. 
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CLASSIFIER GENERATION 
 

The SSVEP Device uses Linear Discriminant Analysis for feature 

classification. To use this signal processing algorithms you have to generate 
corresponding classifiers first. 
 
Double click the Paradigm block. 
 

Enter classinfo_20tr.m as Filename and select Training Paradigm as 

Mode. 
 

Set the Trial Period to 10.5 s, the Active Part to 70 % and the Initial Offset to 10 s. 

 
Press OK to close the window. 
 
 
Then double-click onto the To File block: 
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Enter under Filename training_session1.mat and under Variable Name y. 

This stores the data into matrix y. 
 
Press OK to close the window. 
 
Double-click on the g.STIMbox block to set the stimulation frequencies. 
 

 
 
Set the COM Port of the g.STIMbox correctly (see g.STIMbox Help). 
 

Enter an Input Sampling Rate of 32 Hz and an Input Frame Length of 1. 

 

Change the Mode of CH 9, CH 11, CH 13, CH 15 to Frequency and enter the 

frequencies 10 Hz, 11 Hz, 12 Hz and 13 Hz (same as in the Stimulation 

Frequencies block). 
 
Press OK to close the window. 
 
 
Start the SSVEP model in the Simulink model menu. 
 
 

After the Initial Offset the LED will start flashing. Look at the left white LED. After the 
Trial Period the next LED will flash (clockwise). The current LED you have to 
concentrate on is marked with the green LED. Between two trials all green LEDs are 
lighting and the user has enough time to switch the focus to the next LED.  
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CLASSIFIER CALCULATION 
 

1. Enter gbsanalyze on the MATLAB command line to start g.BSanalyze. 

 
2. Select Load Data from the g.BSanalyze File menu and load the acquired data 

file training_session1.mat. 

 

3. Enter a Sampling Rate of 256 Hz. 

 

 
 

 
4. The first channel is a time step signal, channel 2 to 9 are the EEG-signals, 

channel 10 is the trigger signal and channel 11 shows the current classification 

result (Paradigm with Feedback). 

 
 
 

Trigger Data 
 
5. To split the data-set into equal trials open the Trigger window under the 

Transform menu. 
 

6. Set the Time before trigger to 3000 ms and the Time after trigger to 7000 

ms. Select channel 10 as Physical channel for triggering and set the 

Threshold level to 90 % of maximum. 

Select e.g. the name TRIG in Assign attribute to resulting trials and press 

button add to list ->. 
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7. Press Select channels … and exclude CH 1, CH 10 and CH 11. 
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8. Press Start! to perform the triggering. 
 

The process results in 20 trials with a length of 10000ms each. 
 
 
 

Load Class Information 
 
9. To assign class information to the 20 trials open Load Class Information of 

the File menu in the Data Editor. Click on the Browse… button and select the 

file classinfo_20tr.m from the following directory: 

 
Your Installation path:\gSSVEP_8ch\ 

 
10. Change the names of the attributes e.g. to 10Hz, 11Hz, 12Hz, 13Hz. Click OK! 

 
 
 

Parameter Extraction - Minimum energy 
 

11. Open the Minimum Energy window from the Parameter_Extraction menu. 
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12. Press Select channels and Select all ->>. 
 

Enter the Frequencies 10,11,12,13 Hz. Set the Number of harmonics to 1 

and the Order of AR model to 7. 

The window length is 3000 ms and the Evaluation step is 200 ms. 

Select Add new channels to add the calculated channels to the data 
channels in the Data Editor. 

 
13. Press Start! to perform the calculation. 

 
 
 

Parameter Smoothing – Moving Window Filter 
 

14. Open Moving Window Filter window from Pre-Processing menu 
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15. Select Moving median 
 

16. Specify length of smoothing window 10 Samples.  
 

17. Click on Select trials/chan, select channels 9, 10, 11 and 12 to be 

smoothed only and confirm the settings with the OK button. 
 

18. Press Start to smooth the data.  
 
 

Baseline Correction 
 
19. Open Arithmetic window from Transform menu 

 

 
 

20. Select Apply on multiple channels for Specify Method and set 

Operation to Z-Median for subtracting the median of all channels from each 

sample. 
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21. Click on Select trials/chan, select channels 9, 10, 11 and 12 to be 

baseline corrected only and confirm the settings with the OK button. 
 

Classification 
 

22. To classify the data open the Feature Matrix from the Classification menu. 
 

23. Set the Start at time to 0 ms (the first sample will be chosen), the Step size to 

500 ms and Stop at to 51 samples (10160.2 ms). Select classes 10Hz, 

11Hz, 12Hz, 13Hz. 

 
24. Click on Select feature channels and select only channels 9 to 12 for the 

classification. 
 

25. Select Linear Discriminant Analysis (LDA) as Classification 

method. 
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26. Press Start to create the feature matrix and to open the Linear Classifier 

window. 
 

27. Perform the classification with a Linear Discriminant Analysis (LDA) 

and with a 10 x 10 cross-validation by pressing again Start. The 10 x 

10 cross-validation mixes the testing and training data. 
gResult2D opens automatically with the classification result. The y-axis shows 
the classification error in %. 
For the Online Classification it is recommended to select a timepoint where the 
classification error is 0%. In the following figure 
(…\Testdata\training_testsubj1.mat) you would chose a timepoint between 
6-6.5. 

 

 
 
 

28. Close the Result2D, Linear Classifier and Feature Matrix window and repeat 
steps 14-19 but now select in the Linear Classifier window as Training / test-

sets Train 100% - Test 100% and save the results in  
 

Your Installation path:\gSSVEP_8ch\train_lda_session1.mat 

 
 
OPTIONAL: CLASSIFIER CALCULATION WITH BATCH 
 
Steps 5-20 can be also performed automatically with a batch. 
Note: You have to use the same parameters as used within this tutorial. 
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1. Enter gbsanalyze in the MATLAB command line to start g.BSanalyze. 

 

2. Load the acquired data file training_session1.mat (Sampling frequency 

256Hz). 

 
3. Select Appearance Settings from the Options menu and set the USER 

DIRECTORY to  
 

Your Installation path:\gSSVEP_8ch\Batch 

 
4. Go to the User menu in g.BSanalyze and select the batch for classifier 

calculation (SSVEP_LDA_ME_Batch_8ch_256Hz). 

 

 
ONLINE CLASSIFICATION 
 
Double click on the Apply Classifier block to load the classifier. 
 

 
 
Load Classifier: Select the *.mat file which contains the classifier results. If you 
followed the tutorial it should be saved under: 
 
Your Installation path:\gSSVEP_8ch\train_lda_session1.mat 

 
Select classifier from list: Select the classifier which should be used for the online 
classification. The left value is the classification error and the right value the time 
point the error was observed. 
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Enable Combine classification result in one channel to compute the probability 
that a sample belongs to a specific class. The class with the highest probability is 
selected on the output of the Apply Classifier block.  
 

Enable Add zero class and set the Confidence interval [%] to 1. This activates the 

rejection of any sample for which no class can be assigned with an uncertainty of 
less than 1%. 
 
 
 
Double click the Paradigm block. 
 

Select Paradigm with feedback as Mode. This mode allows to calculate the 

accuracy of the online classification. 
 

Set the Trial Period to 10.5 s, the Active Part to 70 % and the Initial Offset to 10 s. 

 
Press OK to close the window. 
 
 

Enter into the To File block fb_session1.mat and Start the Simulink model. 

The task for the subject remains the same as with Training Paradigm. 

If you would choose Free running the white LEDs would flash all the time and you 

will get a continuous online classification result (can be seen in the Display block or 
as movement of the robot) but you are not able to calculate the accuracy with 
g.BSanalyze. 
 

To control the epuck, set the constant of the Enable epuck block to 1. 
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DATA STORAGE AND VISUALIZATION 
 
Double-click onto the Scope block to investigate the signals: 
 

 
 

The channels 1-8 show the EEG data. The 9th channel displays the trigger signal, if 
it is high you have to concentrate on a LED and the 10th channel indicates the 
classification result 1 – 4  ( 10Hz, 11Hz, 12Hz and 13Hz.) or 0 in case no class 
could be assigned. 
 
The To File block stores these 10 channels plus the automatically stored time stamp 
of each sample (see documentation of Simulink To File .block for further details) 
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OFF-LINE PROCESSING 
 

Type into the MATLAB command window gbsanalyze to start the Data Editor. Load 

the data file acquired during the Paradigm with feedback (fb_session1.mat) trial 

to calculate the accuracy of the online classification. 
 

 
If your user directory is not already set, select Appearance Settings from the 
Options menu and set the USER DIRECTORY to  
 
Your Installation path:\gP300_8ch\Batch 

 

Go to the User menu in g.BSanalyze and select the batch 
SSVEP_online_accuracy_batch. 

 

 
 

 

The x-axis specifies the time and the y-axis shows the classification error (blue line) 
and the false positive classifications (green line) in %. A sample is considered to be 
false positive classified if the assigned class is greater than 0 and not equal to the 
class expected for each trial. The red line marks the trigger, the LEDs start to flash. 
Before the trigger the classification result should be 0 and after the Trigger the error 
should be reduced significantly. The buffer length of 3s selected for the Minimum 
Energy and the Moving Median block of 2s causes an average delay of about 3s 
before the user action can be detected. In the shown example the break between two 
trials was selected to be 3s which is equal to the pre trigger time and the average 
interval required to detect that the user is not looking anymore at the previous LED. 
This is the main reason for the false positive classifications prior to the trigger. 
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SUMMARY 
 
The new Simulink Highspeed On-line Processing blocks g.USBamp and 
g.MOBIlab+ allows setting up a SSVEP Brain Computer Interface. 
The parameter extraction is independent from the paradigm and the classifier, so it 
can be replaced by other algorithms. Also different classification methods can be 
used (Linear Discriminant Analysis, Support Vector Machine…). 
 
 
To perform the tutorial the following components are required: 
 
g.USBamp or g.MOBIlab+ biosignal acquisition device 
Simulink Highspeed On-line Processing blocks for g.USBamp or g.MOBIlab+ 
g.RTanalyze 
g.BSanalyze off-line processing toolbox 
g.STIMbox 
g.SSVEPbox 
g.GAMMAbox 
EEG electrodes and an EEG cap 
PC or notebook with USB connector or Bluetooth 
MATLAB and Simulink Release 2012a 
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